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SimMechanics Release Notes

Summary by Version
This table provides quick access to what’s new in each version. For
clarification, see “About Release Notes” on page 2.

Version
(Release)

New
Features
and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation
at Web Site

Latest
Version
V2.6
(R2007a)

Yes
Details

Yes
Summary

Bug Reports
Includes fixes

Printable Release
Notes: PDF

Current product
documentation

V2.5
(R2006b)

Yes
Details

Yes
Summary

Bug Reports
Includes fixes

No

V2.4
(R2006a)

Yes
Details

No Bug Reports
at Web site

No

V2.3
(R14SP3)

Yes
Details

No Bug Reports
at Web site

No

V2.2.2
(R14SP2)

Yes
Details

No Bug Reports
at Web site

No

V2.2.1
(R14SP1)

Yes
Details

No Fixed bugs
at Web site

No

V2.2 (R14) Yes
Details

Yes
Summary

Fixed bugs
at Web site

No

V2.1.1
(R13SP1)

No No Yes
Details

No

V2.1
(R13+)

Yes
Details

No Fixed bugs
at Web site

No
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Version
(Release)

New
Features
and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation
at Web Site

V2.0.1
(R13+)

No No Yes
Details

No

V2.0
(R13+)

Yes
Details

No Fixed Bugs
at Web Site

No

About Release Notes
Use release notes when upgrading to a newer version to learn about new
features and changes, and the potential impact on your existing files and
practices. Release notes are also beneficial if you use or support multiple
versions.

If you are not upgrading from the most recent previous version, review release
notes for all interim versions, not just for the version you are installing. For
example, when upgrading from V1.0 to V1.2, review the New Features and
Changes, Version Compatibility Considerations, and Bug Reports for V1.1
and V1.2.

New Features and Changes
These include

• New functionality

• Changes to existing functionality

• Changes to system requirements (complete system requirements for the
current version are at the MathWorks Web site)

• Any version compatibility considerations associated with each new feature
or change

Version Compatibility Considerations
When a new feature or change introduces a known incompatibility between
versions, its description includes a Compatibility Considerations

2
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Summary by Version

subsection that details the impact. For a list of all new features and
changes that have compatibility impact, see the “Compatibility Summary for
SimMechanics” on page 31.

Compatibility issues that become known after the product has been released
are added to Bug Reports at the MathWorks Web site. Because bug fixes can
sometimes result in incompatibilities, also review fixed bugs in Bug Reports
for any compatibility impact.

Fixed Bugs and Known Problems
MathWorks Bug Reports is a user-searchable database of known problems,
workarounds, and fixes. The MathWorks updates the Bug Reports database
as new problems and resolutions become known, so check it as needed for
the latest information.

Access Bug Reports at the MathWorks Web site using your MathWorks
Account. If you are not logged in to your MathWorks Account when you link
to Bug Reports, you are prompted to log in or create an account. You then can
view bug fixes and known problems for R14SP2 and more recent releases.

The Bug Reports database was introduced for R14SP2 and does not include
information for prior releases. You can access a list of bug fixes made in prior
versions via the links in the summary table.

Related Documentation at Web Site

Printable Release Notes (PDF). You can print release notes from the PDF
version, located at the MathWorks Web site. The PDF version does not
support links to other documents or to the Web site, such as to Bug Reports.
Use the browser-based version of release notes for access to all information.

Product Documentation. At the MathWorks Web site, you can access
complete product documentation for the current version and some previous
versions, as noted in the summary table.
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Version 2.6 (R2007a) SimMechanics
This table summarizes what’s new in Version 2.6 (R2007a):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes Yes—Details labeled
as Compatibility
Considerations,
below. See also
Summary.

Bug Reports
at Web site

Printable Release
Notes: PDF

V2.6 product
documentation

New features and changes introduced in this version are

• “SimMechanics Now Requires Simscape” on page 4

• “Sharing Models Using Simscape Editing Modes” on page 4

• “Block Library Links Must Be Resolved” on page 5

• “Two Blocks Now with Tunable Parameters” on page 5

• “Demos Expanded” on page 6

• “Modeling Constraints with SimMechanics” on page 6

SimMechanics Now Requires Simscape
SimMechanics now depends on and requires Simscape, the foundation for
Physical Modeling products. Simscape includes common Physical Modeling
utilities and block libraries. See “What Is SimMechanics?” and the Simscape
documentation.

Sharing Models Using Simscape Editing Modes
SimMechanics now features a selection of two Simscape editing modes that
allow full or restricted editing of models.

• The Restricted mode requires SimMechanics to be installed, but does not
require a license. It allows you to change a limited set of model parameters,
but not the blocks or connections, in a SimMechanics model.
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Version 2.6 (R2007a) SimMechanics

• The Full mode requires both Simscape and SimMechanics to be installed.
It allows you to change anything in a SimMechanics model.

For more details, see “Using the Simscape Editing Mode” in “Running
Mechanical Models”.

Block Library Links Must Be Resolved
All SimMechanics blocks in your models must now have resolved block library
links. You can neither disable nor break these library links. This is a global
requirement of Simscape. Consult the Simscape documentation for further
details.

Compatibility Considerations
If you have an existing SimMechanics model with disabled or broken links
from SimMechanics blocks to the SimMechanics block library, you must
restore all the broken block library links for your model to be valid.

If you have disabled or broken the SimMechanics library link for blocks that
you have customized and want to keep these modified blocks in your model,
you must move these modified blocks to your own custom library or libraries,
then copy the block instances that you need to your model.

You must still restore the block link to its parent library, whether that parent
library is SimMechanics or your own.

Two Blocks Now with Tunable Parameters
These SimMechanics parameters are now tunable from their respective block
dialogs:

• The Gravity vector field of the Machine Environment block.

• All three parameter fields of the Body Spring & Damper block.

See “Limitations” in “Running Mechanical Models” for more about tunable
parameters in SimMechanics and the Simulink documentation for tunable
parameters in general.
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Demos Expanded
Five new demos have been added to SimMechanics.

Angular Motion Equivalence
The mech_gimbal_transform demo shows the equivalence of a body’s angular
motion as measured by Joint Sensors and as measured by Body Sensors.

Joint Limit Demos
Two demos illustrate how to model limits or clearance on joint motion:

• mech_jointlimit_prismatic

• mech_jointlimit_revolute

The first illustrates limits on translational motion; the second, limits on
rotational motion.

Stochastic Oscillator and Controller Demos
Two demos simulate a mixture of deterministic and random forces with a
model of a micromechanical damped linear oscillator:

• mech_brownian_osc

• mech_brownian_osc_control

The first model has no controller; the second, a control force in addition to the
damped spring and white noise forces.

Modeling Constraints with SimMechanics
A new MATLAB Digest article explains how to model mechanical constraints
with SimMechanics. The article uses a set of four existing SimMechanics
demos as illustrations.

6
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Version 2.5 (R2006b) SimMechanics
This table summarizes what’s new in Version 2.5 (R2006b):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes Yes—Details labeled
as Compatibility
Considerations,
below. See also
Summary.

Bug Reports
at Web site

No

New features and changes introduced in this version are described here.

• “Computer-Aided Design Translator for Pro/ENGINEER Available via
the Web” on page 7

• “SolidWorks-to-SimMechanics Translator Now Available Only via the
Web” on page 8

• “New Demo” on page 9

• “Modeling Flexible Bodies with SimMechanics” on page 9

Computer-Aided Design Translator for Pro/ENGINEER
Available via the Web
A new computer-aided design (CAD) Pro/ENGINEER-to-SimMechanics
translator is available. You install and use this translator with
Pro/ENGINEER. It is independent of MATLAB.

The translator converts a Pro/ENGINEER CAD machine assembly into an
XML file in the Physical Modeling format. The XML file represents the
assembly in a form that you can use with SimMechanics to generate a block
diagram model dynamically equivalent to the original CAD assembly. To
generate models, use the import_physmod command.

7
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Installing the Pro/ENGINEER-to-SimMechanicsTranslator
Obtain and use the installer executable by locating and downloading its
archive at www.mathworks.com/products/simmechanics/. A README page
is provided that describes installation and configuration details.

Translator Documentation
Help files accompany the Pro/ENGINEER-to-SimMechanics translator. They
include two HTML pages and a PDF book. These files are independent of
the MATLAB help system.

Translator Examples
Some examples of Pro/ENGINEER CAD assemblies are included with the
Pro/ENGINEER-to-SimMechanics translator.

One of the examples is a robot arm assembly. The corresponding
XML file in Physical Modeling format, robot.xml, is located in the
toolbox/physmod/mech/mechdemos/ directory, relative to your MATLAB root.

Compatibility Considerations
The Pro/ENGINEER-to-SimMechanics translator works with Pro/ENGINEER
Wildfire Versions 2 and 3 but is available for the Microsoft Windows (32-bit)
operating system only.

SolidWorks-to-SimMechanics Translator Now
Available Only via the Web
The existing SolidWorks-to-SimMechanics translator for the
SolidWorks CAD platform continues to be available via the Web, at
www.mathworks.com/products/simmechanics/. However, it no longer ships
with SimMechanics.

Compatibility Considerations
The SolidWorks CAD platform and the SolidWorks-to-SimMechanics
translator are available only for the Microsoft Windows operating system.

8
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The SolidWorks-to-SimMechanics translator works with SolidWorks 2004,
SolidWorks 2005, and SolidWorks 2006. The translator is no longer
compatible with earlier versions of SolidWorks.

An older version of this translator is available via the MathWorks Web site.
This version supports SolidWorks 2001 Plus and SolidWorks 2003.

New Demo
This version of SimMechanics includes one new demo model,
mech_brownian_osc, a stochastic linear harmonic oscillator based on micro-
and biomechanics.

Modeling Flexible Bodies with SimMechanics
A new MATLAB Digest article and related technical paper explain how to
model flexible bodies with SimMechanics and third-party finite element
analysis applications. A set of models accompanies the technical paper in a
compressed zip archive available from MATLAB Central.
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Version 2.4 (R2006a) SimMechanics
This table summarizes what’s new in V2.4 (R2006a):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes Yes—Details labeled
as Compatibility
Considerations,
below. See also
Summary.

Bug Reports
at Web site

No

New features and changes introduced in this version are described here.

• “New Block Dialogs and the Simulink Model Explorer” on page 10

• “Joint Spring & Damper Adds Extra Simulink State When Connected to a
Revolute” on page 10

• “Improved SolidWorks CAD Translation” on page 11

New Block Dialogs and the Simulink Model Explorer
Most of the SimMechanics block dialogs have been upgraded and are
now compatible with the Simulink® Model Explorer. See the Simulink
documentation for more about Model Explorer.

Block Dialogs Not Rendered in Model Explorer
Model Explorer cannot render the dialogs of these blocks:

• Shared Environment

• Point-Curve Constraint

Joint Spring & Damper Adds Extra Simulink State
When Connected to a Revolute
In the new version of SimMechanics, each Joint Spring & Damper block
connected to a revolute primitive adds a Simulink state to your model.

10
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These states are in addition to other normal Simulink states, such as those
associated with Integrator and Transfer Fcn blocks. See the Simulink
documentation for more about Simulink model states.

This new feature does not change the mechanical states of your model, those
associated with SimMechanics joint blocks. See the mech_stateVectorMgr
command reference for more about mechanical states.

Improved SolidWorks CAD Translation
The SolidWorks-to-SimMechanics translator and Physical Modeling XML
import command have been improved. See “Modeling with Computer-Aided
Design” and the import_physmod command reference in the SimMechanics
User’s Guide.

• Mates in a CAD assembly (restrictions on the free motion of CAD parts)
are now translated into Joint blocks that reflect a particular combination
of joint primitives, such as Prismatic, Revolute, Spherical, Bushing, etc.
Previously, all degrees of freedom in a CAD assembly were translated into
appropriately configured Custom Joint blocks. Rigid connections between
parts continue to be translated into Welds.

• Blocks in SimMechanics models generated from Physical Modeling XML
files are now, by default, labeled with shorter names. You can change the
naming convention in the import_physmod command options.

11
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Version 2.3 (R14SP3) SimMechanics
This table summarizes what’s new in V2.3 (R14SP3):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes No Bug Reports
at Web site

No

New features and changes introduced in this version are described here.

• “New Shared Environment Block” on page 12

• “Updated Body Spring & Damper Block” on page 12

• “Normalizing Rotations” on page 13

• “New State Vector Commands” on page 13

• “New import_physmod Dialog” on page 13

• “Demos Expanded” on page 13

• “Documentation Enhancements” on page 14

New Shared Environment Block
The new Shared Environment block allows you to link two separate
SimMechanics block diagrams with a nonphysical connection. The block
enforces the same machine environment settings on both machines but adds
no mechanical components (bodies or degrees of freedom) to either. Two
machines so connected require exactly one Machine Environment block,
rather than two.

See the Shared Environment block reference for further details.

Updated Body Spring & Damper Block
The Body Spring & Damper block no longer contains any degrees of freedom.

12
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Previous versions of the Body Spring & Damper block contained six degrees
of freedom (DoFs) represented by a Joint. This Joint had to be taken into
account when counting DoFs and loops in your model.

The new Body Spring & Damper block instead uses a Shared Environment
block to connect the two sides and contains no DoFs. See their respective
block references for more information.

Normalizing Rotations
The Body dialog accepts various rotational forms (Euler angles, rotation
matrix, quaternion). SimMechanics now interprets these rotational forms in
a slightly different way, so that the standard normalization conditions on
rotation matrices and quaternions are consistently enforced. As a result, you
might now see slightly different simulation results from earlier versions.

New State Vector Commands
SimMechanics features four new commands that allow you to manipulate the
mechanical states of your models. See the command references for more.

• mech_get_states

• mech_runtime_states

• mech_set_states

• mech_transfer_states

New import_physmod Dialog
The import_physmod command generates SimMechanics models from
Physical Modeling XML files. In addition to importing Physical Modeling XML
through the command line, you can now set up the command through a dialog.

See the import_physmod command reference for further information.

Demos Expanded
Two new demos have been added to SimMechanics:

• mech_flexible_four_bar models a flexible four bar machine.
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• mech_pole_vault models a rigid pole vaulter, with a discrete event.

The second demo has an associated MAT-file.

Documentation Enhancements
The SimMechanics User’s Guide has been enhanced.

• The review chapter on representing motion has been revised.

• The motion analysis chapter has been revised.

• The computer-aided design (CAD) documentation (also available as a
separate book) has been significantly revised. See the CAD chapter.

• A new chapter of case studies, based on the Stewart platform, has been
added. The studies apply advanced methods and tasks to this system.
SimMechanics includes a related set of demo model and library files.

- Degrees of freedom, states, closed topology, and constraints

- Trimming and linearization

- Designing controllers for the platform

- Generating code versions of the model

- Implementing code on dedicated hardware (hardware in the loop)

14
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Version 2.2.2 (R14SP2) SimMechanics
This table summarizes what’s new in V2.2.2 (R14SP2):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes
Details below

No Bug Reports
at Web site

No

New features and changes introduced in this version are described here.

• “Demos Expanded” on page 15

• “Documentation Enhancements” on page 15

Demos Expanded
Two new demos have been added to SimMechanics:

• mech_sticky_box

• mech_sticky_screw

Each demo has an associated MAT-file.

These demos illustrate static friction (stiction) implemented with the Joint
Stiction Actuator.

Documentation Enhancements
The online SimMechanics Help has been enhanced with links to four new
Web-based AVI animation files (one of them new in this release) that record
SimMechanics simulations.

You can access these links most easily by using the Examples index in the
Help browser, under Prerecorded Animations.
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Version 2.2.1 (R14SP1) SimMechanics
This table summarizes what’s new in V2.2.1 (R14SP1):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes No Fixed bugs
at Web site

No

New features and changes introduced in this version are described here.

• “Demos Updated and Expanded” on page 16

• “Documentation Enhancements” on page 16

Demos Updated and Expanded
The demos used in the open-topology Inverse Dynamics case study have been
changed:

• mech_dpend_invdyn1

• mech_dpend_invdyn2

• mech_dpend_act (a new demo replacing mech_dpend_stat)

The last, new demo has an associated MAT-file, mech_dpend_act.mat. See
“Documentation Enhancements” on page 16.

Two other new SimMechanics demos have been added:

• mech_cambelt models a cam, belt, and pulley system with a Point-Curve
Constraint block.

• mech_viscous illustrates how to model a viscous medium with a Joint
Spring-Damper block.

Documentation Enhancements
The online SimMechanics Help has been enhanced with additional
multimedia support.

16
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• The online Help contains four detailed mechanical drawings for systems
modeled in the user’s guide: the conveyor, the four bar machine, and the
Stewart platform.

• The online Help also contains links to three new Web-based AVI animation
files that record SimMechanics simulations.

You can access these features most easily by using the Examples index
in the Help browser, under Mechanical Drawings and Prerecorded
Animations, respectively.

The open-topology Inverse Dynamics section of the motion analysis chapter
has been enhanced with a new, more complex and more realistic example.
The related demos have been changed as well; see “Demos Updated and
Expanded” on page 16 previously.
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Version 2.2 (R14) SimMechanics
This table summarizes what’s new in V2.2 (R14):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes Yes—Details labeled
as Compatibility
Considerations,
below. See also
Summary.

Fixed bugs
at Web site

No

New features and changes introduced in this version are described here.

• “Simulation and Visualization Controls Changes” on page 19

• “New Machine Environment Block” on page 19

• “Choosing a Ground Block as Machine Root” on page 20

• “Optional Two-Dimensional Solver” on page 20

• “Optional Gravity Signal” on page 20

• “New SimMechanics Diagnostics Settings” on page 21

• “Restricted Body Coordinate System References” on page 21

• “Minimum Number of Body Coordinate Systems” on page 21

• “Visualization Controls Relocated” on page 22

• “Manual Updating of Body Visualization” on page 22

• “Internal Virtual Reality Visualization No Longer Supported” on page 22

• “Code Generation with Point-Curve Constraint Now Enabled” on page 23

• “Code Generation Improvements” on page 23

• “Additional Simulink Features Now Supported” on page 23

• “SimMechanics Now Supported on HP-UX Platforms” on page 23

• “Demos Updated and Expanded” on page 23

18
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• “Documentation Enhancements” on page 24

Simulation and Visualization Controls Changes
This version of SimMechanics introduces significant changes to how
you control simulation, mechanical environment, and visualization in
SimMechanics models. These changes, summarized below, include

• “New Machine Environment Block” on page 19

• “Choosing a Ground Block as Machine Root” on page 20

• “Optional Two-Dimensional Solver” on page 20

• “Optional Gravity Signal” on page 20

• “New SimMechanics Diagnostics Settings” on page 21

• “Visualization Controls Relocated” on page 22

• “Manual Updating of Body Visualization” on page 22

The new controls are fully documented in the SimMechanics User’s Guide
chapters on running simulations and visualization.

New Machine Environment Block
In the new version of SimMechanics, you configure the mechanical
environment for an entire model in the SimMechanics node of the
Configuration Parameters dialog, accessed via the Simulation menu. You
configure the mechanical environment for each separate machine diagram
(one or more per model) via its Machine Environment block. These two dialogs
replace the old Mechanical Environment Settings dialog.

You must connect exactly one Machine Environment block to each separate
machine diagram at one of the machine’s Ground blocks. The new Machine
Environment block is located in the Bodies library.

See “Choosing a Ground Block as Machine Root” on page 20.

Compatibility Considerations
Prior to this version, SimMechanics models recorded mechanical environment
data in the Mechanical Environment Settings dialog. Although you can
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no longer access this dialog from the Simulation menu, you can continue
to run old models as they are. If you want to view these old settings, enter
mech_environment(gcs) at the command line with your old model open. You
cannot change the dialog settings.

If you want to change the settings in old models or build a new SimMechanics
model, you must use the new Machine Environment block. Copying this
block from the Bodies library into an old model causes the old Mechanical
Environment Settings data to be copied into the block. You can then
reconfigure the new block as you want.

Choosing a Ground Block as Machine Root
The new Ground block has the option of being chosen as the root for a
machine’s Machine Environment block. In each separate machine diagram
(one or more per model), choose one such Ground by selecting Show
Mechanical Environment port in its dialog. The corresponding port then
appears on the Ground. Then connect a Machine Environment block to the
Ground at this port.

See “New Machine Environment Block” on page 19.

Optional Two-Dimensional Solver
The new Machine Environment block allows you to choose, through its
Machine dimensionality pull-down menu, a specialized solver for a machine
that moves in only two dimensions. SimMechanics detects the dimensionality
and automatically adjusts the solver by default. But you can override the
default and require SimMechanics to work in either three or two dimensions.

The two-dimensional solver significantly improves simulation performance
in two and one dimensions.

Optional Gravity Signal
The new Machine Environment block allows you to input gravity as an
external Simulink® signal. In the block dialog, select Input gravity as
signal. A Simulink inport appears for connecting the Simulink signal line.
The gravity must be a three-component vector signal. You choose the units in
the Gravity vector units pull-down menu of the block dialog. SimMechanics

20
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interprets the vector gravity signal the same way it interprets the static
Gravity vector field value in the block dialog.

If you choose gravity as a signal, the Gravity vector field is ignored.

New SimMechanics Diagnostics Settings
SimMechanics now lets you control diagnostic messages. In the
SimMechanics node of the Configuration Parameters dialog, accessed via
the Simulation menu, you can select to enable or disable certain warning
messages, and whether to mark closed-loop joints cut automatically by
SimMechanics.

Restricted Body Coordinate System References
All coordinate system (CS) references in Body blocks from one CS to another
CS must now refer to only

• Other CSs on the same Body

• Adjoining CSs (coordinate systems on Bodies directly connected to the
referring body)

• World

All other CS references now cause simulation errors.

Compatibility Considerations
Other types of CS references from one Body to another now lead to simulation
errors. If any of your old models contain such references, you must update
them.

Minimum Number of Body Coordinate Systems
You can no longer eliminate all the non-center-of-gravity (CG) Body coordinate
systems (CSs) on a Body block dialog. Besides the undeletable CG CS entry,
at least one non-CG CS must remain.
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Visualization Controls Relocated
You now enable SimMechanics visualization and animation for an entire
model in the Visualization area of the SimMechanics node of the
Configuration Parameters dialog, reached via the Simulation menu. You
now enable or disable visualization for individual machines within a model
via the Visualization pane of the Machine Environment block dialog. See
“New Machine Environment Block” on page 19.

All SimMechanics visualization controls are now located on the specially
configured MATLAB® Graphics visualization window, in the SimMechanics
menu and toolbar.

Manual Updating of Body Visualization
SimMechanics visualization no longer immediately displays a Body newly
added to a model. Instead you must update the model by selecting Update
Diagram from the Edit menu.

Internal Virtual Reality Visualization No Longer
Supported
SimMechanics no longer includes internally integrated Virtual Reality
Toolbox visualization. Models configured to use virtual reality now default to
the MATLAB Graphics visualization/animation tool, which is still supported
by SimMechanics.

See the virtual reality section of the visualization chapter in the SimMechanics
documentation.

Consult the Web product page for more about Virtual Reality Toolbox.

Compatibility Considerations
You can continue to use Virtual Reality Toolbox with SimMechanics by
creating your own virtual world for your machine, incorporating into your
model a VR Sink block linked to your virtual world, and feeding Body Sensor
signals to the VR Sink.
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Code Generation with Point-Curve Constraint Now
Enabled
The Point-Curve Constraint no longer creates algebraic loops in Simulink.
This improvement means that you can now generate code from models
containing Point-Curve Constraints.

Code Generation Improvements
The stand-alone SimMechanics library used for code generation is now
precompiled for supported platforms using standard targets. This feature
significantly speeds up compilation of generated code.

SimMechanics code generation now supports Real-Time Windows Target.

Additional Simulink Features Now Supported
SimMechanics now supports Model Referencing and S-function target. It
also now supports Simulink External mode, but without visualization.
See the sections on generating code and SimMechanics limitations in the
SimMechanics documentation.

SimMechanics Now Supported on HP-UX Platforms
SimMechanics is now supported on the Hewlett-Packard UNIX (HP-UX)
operating system.

Demos Updated and Expanded
All SimMechanics demos have been updated with the new Machine
Environment block. New demos have also been added:

• mech_bouncing_ball demonstrates how to model impact and collisional
forces using a bouncing ball.

• mech_flyball models a flyball governor mechanism.

• mech_rack_pinion models a driven rack-and-pinion mechanism.

• mech_rolling_sphere demonstrates how to model nonholonomic
constraints using a sphere rolling on a two-dimensional surface.
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• mech_toroid illustrates the Point-Curve Constraint with a body sliding
on a toroidal curve.

Documentation Enhancements
The SimMechanics User’s Guide has been enhanced.

• The review chapter on body motion and coordinate systems is expanded
with greater detail and more examples.

• The computer-aided design (CAD) documentation (also available as a
separate book) has been significantly revised and expanded. See the CAD
chapter.

• The case study sections on trimming and linearization have been revised
and expanded, including a new closed-loop linearization example.

You can find a more complex closed-loop linearization example using a
Stewart platform model at

www.mathworks.com/company/newsletters/digest/sept02/stewart.html
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Version 2.1.1 (R13SP1) SimMechanics
This table summarizes what’s new in V2.1.1 (R13SP1):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

No No Yes
Details below

No

New changes introduced in this version are described here.

Model Reinitialization After Simulation Errors
Restarting a model that had encountered an error during a previous
simulation sometimes led SimMechanics to return warnings and zero results.
Starting the model a third time reproduced the errors of the first simulation.
This bug is now fixed.
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Version 2.1 (R13+) SimMechanics
This table summarizes what’s new in V2.1 (R13+):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes
Details below

No Fixed bugs
at Web site

No

New features and changes introduced in this version are described here.

• “Computer-Aided Design Translator for SolidWorks” on page 26

• “import_physmod Command for Generating Models” on page 27

• “Documentation and Examples for SolidWorks-to-SimMechanics
Translator” on page 27

Computer-Aided Design Translator for SolidWorks
SimMechanics 2.1 contains a standalone computer-aided design (CAD)
translator for the SolidWorks® CAD platform. You install and use this
translator with SolidWorks but independently of MATLAB.

The translator converts a SolidWorks CAD machine assembly into an XML
file in the Physical Modeling format. The XML file represents the assembly
in a form that you can use with SimMechanics to generate a block diagram
model dynamically equivalent to the original CAD assembly. To generate
models, use the new import_physmod command. See “import_physmod
Command for Generating Models” on page 27 below.

Installing the SolidWorks-to-SimMechanics Translator
Obtain the self-extracting executable archive
SimMechanics_Translator_for_SolidWorks.exe by locating and
downloading its archive at www.mathworks.com/products/simmechanics/.
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import_physmod Command for Generating Models
Using the CAD-to-SimMechanics translator, you export a CAD assembly into
an XML file in the Physical Modeling format. (See “Computer-Aided Design
Translator for SolidWorks” on page 26.)

This XML file represents the assembly in a form that you can use to
generate a SimMechanics block diagram model dynamically equivalent to the
original CAD assembly. You generate the model from the XML file with the
import_physmod command.

The generated model contains Bodies and Joints that represent the original
parts and degrees of freedom of the assembly. You can edit the generated
model to add additional SimMechanics and Simulink blocks.

Documentation and Examples for
SolidWorks-to-SimMechanics Translator
The SimMechanics User’s Guide has not been updated for this release.

Translator Documentation
Special help files accompany the SolidWorks-to-SimMechanics translator.
They include two HTML pages and a PDF book. These files are independent
of the MATLAB help system.

Translator Examples
Some examples of SolidWorks CAD assemblies are included with the
SolidWorks-to-SimMechanics translator.

One of the examples is a robot arm assembly. The corresponding
XML file in Physical Modeling format, robot.xml, is located in the
toolbox/physmod/mech/mechdemos directory, relative to your MATLAB root.
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Version 2.0.1 (R13+) SimMechanics
This table summarizes what’s new in V2.0.1 (R13+):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

No No Yes
Details below

No

New changes introduced in this version are described here.

Code Compilation with lcc Compiler
Attempting to compile code generated from SimMechanics models using lcc
led to errors in Version 2.0. This bug is now fixed.
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Version 2.0 (R13+) SimMechanics
This table summarizes what’s new in V2.0 (R13+):

New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Related
Documentation at
Web Site

Yes
Details below

No Fixed Bugs
at Web Site

No

New features and changes introduced in this version are described here.

• “Code Generation with Real-Time Workshop” on page 29

• “Accelerator Mode and Discrete Events” on page 29

• “Expanded Handle Graphics Visualization Features” on page 30

• “Variable Body Mass and Inertia Tensor” on page 30

• “Vectorized Joint Initial Condition Actuation” on page 30

• “Damped Linear Force Element Blocks” on page 30

• “New Mechanical Branching Bar Block” on page 30

Code Generation with Real-Time Workshop
You can now generate stand-alone C code from SimMechanics models using
Real-Time Workshop®. You can also export it to a PC kernel using xPC Target.

SimMechanics 2.0 requires Real-Time Workshop 5.0.1 or later to generate
code for the Rapid Simulation (RSIM) target.

Accelerator Mode and Discrete Events
Accelerator mode now supports discrete events associated with the Joint
Stiction Actuator and the Point-Curve Constraint.
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Expanded Handle Graphics Visualization Features
The MATLAB Graphics visualization tool of SimMechanics has a large
number of new features, including recording and playback of simulation
animations.

Variable Body Mass and Inertia Tensor
The Sensors & Actuators library features a new Variable Mass & Inertia
Actuator block. This block accepts Simulink signals that vary the mass and/or
inertia tensor of the Body block to which it is connected. The block only
simulates the changes in the body’s mass properties and does not simulate the
effect of the thrust forces or torques resulting from the accretion or ejection
of mass.

Vectorized Joint Initial Condition Actuation
The Joint Initial Condition Actuator block now lists all the primitives in the
Joint block to which it is connected. You can set initial positions/angles and
initial velocities separately for each prismatic and revolute primitive.

Damped Linear Force Element Blocks
This release introduces a new block library, Force Elements, with two
blocks representing damped linear harmonic oscillator forces. The Body
Spring-Damper block simulates a damped spring-like force between two
bodies. The Joint Spring-Damper block actuates a joint primitive with a
damped spring-like force or torque.

New Mechanical Branching Bar Block
The Utilities library features the new Mechanical Branching Bar block.
You can use this block to map multiple sensor and actuator lines to one
sensor/actuator port on a Joint, Constraint, or Driver or to one Body
coordinate system on a Body.

30



Compatibility Summary for SimMechanics

Compatibility Summary for SimMechanics
This table summarizes new features and changes that might cause
incompatibilities when you upgrade from an earlier version, or when you
use files on multiple versions. Details are provided in the description of the
new feature or change.

Version
(Release)

New Features and Changes with Version
Compatibility Impact

Latest Version
V2.6 (R2007a)

See the Compatibility Considerations subheading
for this new feature:

• “Block Library Links Must Be Resolved” on page 5

V2.5 (R2007a) See the Compatibility Considerations subheading for
each of these new features:

• “Computer-Aided Design Translator for
Pro/ENGINEER Available via the Web” on
page 7

• “SolidWorks-to-SimMechanics Translator Now
Available Only via the Web” on page 8

V2.4 (R2006a) No

V2.3 (R14SP3) No

V2.2.2 (R14SP2) No

V2.2.1 (R14SP1) No

V2.2 (R14) See the Compatibility Considerations subheading for
each of these new features or changes:

• “New Machine Environment Block” on page 19

• “Restricted Body Coordinate System References” on
page 21

• “Internal Virtual Reality Visualization No Longer
Supported” on page 22

V2.1.1 (R13SP1) No
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Version
(Release)

New Features and Changes with Version
Compatibility Impact

V2.1 (R13+) No

V2.0.1 (R13+) No

V2.0 (R13+) No
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